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 FSP200 Development Kit for  
Nucleo Quick Start Guide  

 
 

The FSP200 is a 6-axis IMU processor, integrating CEVA's Hillcrest Labs business unit’s high-performance 
sensor hub software stack, to provide heading and orientation outputs. When connected to one of 
several supported sensors, it performs all the accelerometer and gyroscope sensor fusion processing 
necessary to produce stable and accurate heading and orientation outputs. This document is intended 
to provide information about the FSP200 Development Kit, the pin connections and software provided 
by Hillcrest to facilitate customer integration. 

1. Hardware	

1.1. Introduction	
 

The FSP200 Development Kit includes a shield known as the FSP200 (“target device”) Development 
Board that is designed for quick and easy development and prototyping.  The shield is designed to 
connect to the STM32F411RE Nucleo (“bridge board”) which is developed and sold by 
STMicroelectronics1 (ST) and is included in the FSP200 Development Kit package. The Nucleo platform 
includes a STM32F411 MCU that serves as the master to the FSP200.  This document includes details for 
connecting and using the FSP200 Development Kit with the ST Nucleo prototyping platform. 

 
1 https://www.st.com/en/evaluation-tools/nucleo-f411re.html 
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Figure 1: FSP200 Development Kit with ST Nucleo 

1.2. Connections	
 

The FSP200 Development Board simply plugs into the Nucleo board and is ready to use.  The reader is 
encouraged to review the FSP200 Datasheet [1] for more information on the pinout configurations. The 
FSP200 communicates with a host system over a UART interface, either in UART-RVC mode, UART-RVC-
LOG mode or in UART-SHTP mode. 

    Dev Board Signal Nucleo 
    JP3.10 NC CN5.10 
    JP3.9 NC CN5.9 
    JP3.8 NC CN5.8 
Dev Board Signal Nucleo  JP3.7 GND CN5.7 
JP1.1 NC CN6.1  JP3.6 NC CN5.6 
JP1.2 VDD CN6.2  JP3.5 NC CN5.5 
JP1.3 NC CN6.3  JP3.4 H_MOSI_ABN CN5.4 
JP1.4 NC CN6.4  JP3.3 NC CN5.3 
JP1.5 NC CN6.5  JP3.2 NC CN5.2 
JP1.6 GND CN6.6  JP3.1 H_RX CN5.1 
JP1.7 GND CN6.7     
JP1.8 NC CN6.8  Dev Board Signal Nucleo 
    JP4.8 NC CN9.8 
Dev Board Signal Nucleo  JP4.7 H_WAKEN_PS0 CN9.7 
JP2.1 CAL_PB CN8.1  JP4.6 RESETN CN9.6 
JP2.2 NC CN8.2  JP4.5 BOOTN CN9.5 
JP2.3 NC CN8.3  JP4.4 H_TX_LEDGRN CN9.4 
JP2.4 PS1 CN8.4  JP4.3 H_INT_LEDRED CN9.3 
JP2.5 NC CN8.5  JP4.2 NC CN9.2 
JP2.6 NC CN8.6  JP4.1 NC CN9.1 
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Figure 2: FSP200 Development Board Interface to Nucleo Host device 

In UART-SHTP mode, the FSP200 uses the Sensor Hub Transport Protocol (SHTP) to communicate with a 
system or application processor (host that connects to the FSP200). The SHTP protocol is documented in 
the Sensor Hub Transport Protocol [4], allowing a customer to potentially develop their own host 
software if they choose to do so. In order to ease customer integration, Hillcrest has developed software 
that runs on a host platform such as the STM32F411RE Nucleo series. The software driver fully 
implements the communication protocol used by the FSP200. Hillcrest provides this software driver 
package as source code. The FSP200 Development Kit has programmed the ST Nucleo to work with the 
Hillcrest PC application to demonstrate functions. Customers who intend to use the FSP200 
Development Kit for their own software development should use the driver package to download new 
firmware. 

In UART-RVC mode, the FSP200 transmits heading and sensor information at 100Hz over the 
H_TX_LEDGRN pin. UART-RVC mode has its own dedicated packet format. It’s not configurable, but 
convenient to get a limited sensor data set for applications. 

UART-RVC-LOG mode is similar to the UART-RVC mode but with the addition of raw accelerometer and 
gyroscope outputs for debug purposes. 

1.3. Host	Interface	Configurations	
The communication interface is configured by setting the protocol selection PS0 and PS1 pins 
appropriately. 

PS1 PS0 FSP200 
Transport 
Protocol 

0 0 UART-RVC-LOG 
0 1 UART-RVC 
1 0 UART-SHTP 
1 1 Reserved 

Figure 3: FSP200 Available Selection of Host Communication Interface 

1.4. Calibration	Button	
There is a calibration button on the board to perform simple calibration. See section 3 for details on 
performing calibration. 
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Figure 4: Simple Calibration Button 
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2. Software	

2.1. FSP200	Development	Kit	
FSP200 Development Kit contains a pre-programmed STM32 Nucleo board with Hillcrest software that 
allows communication between the FSP200 and Freespace™ MotionStudio 2.  

Freespace™ MotionStudio 2 is a Windows application to allow users to control and configure the FSP200 
through a USB interface. FSP200 Development Kit can be used for a quick evaluation of the FSP200. A 
generalized system diagram is shown in Figure 5. 

 

 

  

 

 

Figure 5: Simplified System Diagram with Freespace™ MotionStudio 2 

2.2. Running	a	PC	Demo	Application	with	FSP200	Development	Kit	

2.2.1. Requirement	
Running Freespace™ MotionStudio 2 with FSP200 development kit requires the following items. 

• ST-LINK/V2 USB driver available from the ST website (http://www.st.com/en/embedded-
software/stsw-link009.html). 

•  ST32 Virtual COM Port Driver from ST website (http://www.st.com/en/development-
tools/stsw-stm32102.html). The FSP200 software package is tested with STSW version 1.4.0. 
Once you downloaded and extracted the driver, follow the readme.txt file for the instruction to 
complete the installation. 

• Freespace™ MotionStudio 2 application from 
https://www.hillcrestlabs.com/downloads/freespace-motionstudio-2 

Connect USB Type A to Mini-B cable to Nucleo board and your PC. The virtual COM port should appear 
in your Device Manager. 

 

Figure 6: Device Manager to Check Installed Driver for ST Virtual COM Port 

Start Freespace™ MotionStudio 2 (MotionStudio2.exe) after FSP200 development kit virtual COM port is 
successfully detected in your PC. 

Nucleo 

Windows PC 
MotionSutdio 2 

(executable) 
 

Bridge 
(binary) 

Preloaded 

 
FSP200 
Dev Brd 



May 2019 1000-4254 Revision 1.2  
www.ceva-dsp.com © 2019 CEVA, Inc.  All rights reserved   6 / 20 
 

2.2.2. Running	PC	Application	

Start	Freespace™	MotionStudio	2	
After you unzip the PC Application package, launch MotionStudio2.exe under MotionStudio2 folder. This 
will open MotionStudio2 window.  

 

Figure 7: Startup Window of Freespace™ MotionStudio 2 

Establish	Connection	to	the	Nucleo	Board	
From the menu panel on the left, select Device Connection. This panel allows users to select device type, 
transport protocol and more.  

• “Device Type” of the bridge is set to ST Nucleo. 
• ST Link Virtual COM Port available in your PC appears in “Virtual COM Port” box. 
• “Target Device” is set to SHTP over I2C by default, but only SHTP over UART and RVC UART are 

available for FSP200. Refer to Section 1.3 for transport protocol selection. The ST Nucleo will set 
the PS0 and PS1 pins to the proper state based on the protocol selection. 

• Use “Connect” button to start. 
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Figure 8 Device Connection Panel in Freespace™ MotionStudio 2 
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Figure 9: Device Connection Window after Successful Communication in Freespace™ MotionStudio 2 

When connection process is completed, the three status indicator text boxes on the upper right corner 
of the panel and the console window on the bottom provide the result of connection process. The three 
status indicators show the status of the connected system and the status of the associated panel. If the 
specific panel supports the protocol used by the connected device, the panel becomes active and shows 
in green color. 

Sensor	Control	
The Sensor Control panel allows the user to enable and disable the various sensors individually. There 
are two ways to control sensors: 

• To enable an individual sensor at a default operation rate, use the check box on the right end of 
the row for each sensor.  

• To enable sensors at specific rates, input the requested operating period, in microseconds, in 
the 'Requested Period (us)" fields. Then click the "Set Sensor Periods" button on the top of the 
panel. All sensors will be updated with the specified operating period. The "Requested Period 
(us)" fields which are left blank or have invalid values are assumed to be "zero". 

In many cases, the sensors do not operate at the exact rate as requested. The actual operating period is 
shown in the "Reported Period (us)" field. Users can also use the "Get Sensor Periods" button on top of 
the panel to refresh the actual operating period for all sensors. 

  



May 2019 1000-4254 Revision 1.2  
www.ceva-dsp.com © 2019 CEVA, Inc.  All rights reserved   9 / 20 
 

 

Figure 10: Sensor Control Panel in Freespace™ MotionStudio 2 

Virtual	Object	
Virtual Object panel shows the orientation of the device. Please note that you need to enable sensors in 
Sensor Control panel, then select the sensor from the drop down menu in Virtual Object panel. The 
sword in the Virtual Object will move according to the device orientation. 

To adjust the camera position, move the cursor to the Virtual object Panel, then press the LEFT mouse 
button. Hold the button down and move the mouse to change the view position. To reset the camera 
position, use the "Reset Camera Position" button.  

To display the game rotation vectors, select the game rotation vectors from the drop down menu, the 
data fields should start updating with the received sensor data. The virtual object will move according to 
the orientation of the hardware. Use the Sensor Control Panel to enable or disable the specific sensor. 
This panel does not control the sensor but displays the output data. 
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Figure 11: Virtual Object Panel in Freespace™ MotionStudio 2 
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X/Y as marked on the board, using right handed rule 

Figure 12: FSP200 Device Orientation 

 

Please follow the instructions below to align your device.  

• Enable Game Rotation Vector and ARVR Stabilized Game Rotation Vector in “Sensor 
Control” panel.  

• Switch to Virtual Object panel and move the background so the black corner of the Hillcrest 
logo on the ground plane points to your forward direction (heading). 

• Hold the FSP200 development kit Y+ axis points to your forward direction as well. 
• Select “Game Rotation Vector” in drop down menu and click “Tare Z”. Now, the sword will 

point to the edge of the Hillcrest logo and is aligned with your device Y+. 
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Figure 13: Sensor Orientation in Virtual Object Panel in Freespace™ MotionStudio 2 

 

2.2.3. Backup	Bridge	Image	
i Please keep in mind that FSP200 Development Kit is programmed to work with a Windows PC 
Application. Development example code explained in the Section 2.4 is different and will overwrite 
the binary image shipped with the FSP200 Development Kit. If you want to switch back to the bridge 
code to run the Windows PC Application, please either download the latest bridge firmware from 
Hillcrest website(https://www.hillcrestlabs.com/downloads/bridge-firmware-for-nucleo), or read 
the Nucleo device memory using STM32 ST-LINK Utility before downloading a new image into the 
Nucleo board. Please follow the instructions below to back up the prebuilt bridge image. 

To save the contents of Nucleo bridge board: 

• Open STM32 ST-LINK Utility 
• Target->Connect 
• Use “Save the displayed content in a Binary File” on the top left corner to save the image 

into a file for future use. 

To program Nucleo bridge board with the saved image: 

• Open STM32 ST-LINK Utility 
• Target->Connect 
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• Target->Program 
• In new window select “File path” to locate previously saved file. 
• Click “Start” 

 

 

Figure 14: STM32 ST-LINK Utility Window 

2.3. Development	Environment	
The example software requires the following items to execute. 

• IAR Embedded Workbench® for ARM (EWARM) by IAR Systems. 
• ST-LINK/V2 USB driver. This driver is available from the ST website and is supported by the IAR 

Embedded Workbench for ARM (EWARM). After installing EWARM, check 
IAR_INSTALL_DIRECTORY\arm\drivers\ST-Link\ Please skip this step if you have installed already 
from Section 2.2.1. 

• ST32 Virtual COM Port Driver from the ST website. Please skip this if you have installed already 
from Section 2.2.1. 
 

 

Figure 15: Installed driver for ST Virtual COM port 
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• Terminal emulator software like Tera Term or PuTTy. Set up the terminal emulator at 115200 – 
8bit – no parity – 1bit stop bit – no flow control. 

2.4. Example	Software	
 

Hillcrest provides a complete software package for the STM32F411RE Nucleo boards.  

The example application for FSP200 development kit source code is available in public github.  

https://github.com/hcrest/sh2-demo-nucleo 

Clone this repository using the --recursive flag with git. Alternatively, you can download a ZIP file from 
the link. An example git clone command is shown below. 

git clone --recursive https://github.com/hcrest/sh2-demo-nucleo.git 

Everything required to obtain outputs from the FSP200 is included in this package. The software package 
incorporates the FSP200 driver, enabling SH2 functionality for the development system. 

 

 

 

 

 

 

Figure 16: Simplified System Diagram (blue indicates driver developed by Hillcrest) 

 

 

Figure 17: Source Code Structure  

The software is organized as an IAR EWARM project that can be dropped into the IAR IDE on a Windows 
PC.  Follow this procedure to compile the project and download the software to the Nucleo board. 
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• Open IAR Embedded Workbench for ARM (EWARM) 
• In the File menu, select Open and choose Workspace. Browse to where the example package is 

extracted and select “sh2-demo-nucleo/EWARM/Project.eww”. This should open an IAR 
workspace with all the files within the project. 

• Select ‘demo-uart’ or ‘fsp200-cal’ in the project configuration. ‘demo-i2c’ and ‘demo-spi’ are 
reserved for BNO08X or FSM30X utilizing the same SH2 protocol, but with different interfaces. 
And fsp200-dfu is used for upgrading the FSP200, please contact Hillcrest Labs for details. 

• In the “Project” menu, select “Rebuild All” to compile the project. 
• After the project is successfully compiled, go to the Project menu and select Download and 

Debug.  

The “sh2” directory contains a full implementation of the Hillcrest communications protocol for the 
FSP200. 

The reader is encouraged to review the FSP200 datasheet [1] and the SH-2 Reference Manual [2] for 
details on how to construct messages. 

The output from the FSP200 is printed through the serial port. The first few lines indicate that the host 
has established proper communication (“Product ID Request”) with the FSP200 and the FSP200 has 
responded with version information (“Product ID Response”). 

• demo-uart project: 

Game Rotation vector is enabled at 100Hz by default and reports are printed through the serial port.  

 

Figure 18: Terminal Emulator Screenshot 
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Figure 19: IAR EWARM Screenshot 

• fsp200-cal project: 

Simple Calibration mode (software controlled method) is entered. The user should follow the 
instructions on the serial window to perform the calibration. A precise 180 degree rotation is 
required between the start orientation and the final orientation. After ‘Calibration completed 
successfully’, it will run into the next cycle of calibration.  
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Figure 20: Simple Calibration Procedure - Start 

 

 

 

Figure 21: Simple Calibration Procedure - Complete 
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3. Simple	Calibration	

3.1. Hardware	Controlled	Simple	Calibration	Method	
Hardware Controlled Simple Calibration only works in RVC mode. 
This procedure follows the example design of calibration signals by pressing the Simple Calibration 
Button in Figure 4:  

• Enter Calibration Mode: Push CAL_PB button to start calibration. Wait for the green LED 
(TX_LEDGRN) to turn on and flash.  
• Rotate: When the green LED is flashing, rotate the device 180° clockwise and stop, then push 
CAL_PB button.  
• Wait for the Calibration Results: 
- The Green LED (TX_LEDGRN) will be turned on to indicate a successful calibration. Reset the 

device to use newly calibrated sensor records.  
- The Red LED (INT_LEDRED) will be turned on to indicate a failed calibration. Rerun the 

calibration a couple of more times. If the calibration still returns a failure, the device is out 
of specification.  

Refer to FSP200 Simple Calibration Usage Guide [3] for more details. 

3.2. Software	Controlled	Simple	Calibration	Method	
Software Controlled Simple Calibration only works in SHTP mode. 
Configuration from the IAR Embedded Workbench “fsp200-cal” shows how to execute the FSP200 
Simple Calibration. SH-2 Reference Manual [2] Section 6.4.11 also shows the details of the commands 
used in the example application.  

• Enter Calibration Mode: startCalStart() shows command to initiate the Simple Calibration. Wait 
for the command response, startCalRx().  

• Rotate: Once a valid response is received, rotate the device 180° clockwise, then send finish 
calibration command, finishCalStart().  

• Wait for the Calibration Results: wait for the finish calibration response, finishCalRx() and check 
the calibration status.  

When Finish Calibration Response returns any error code, rerun the Simple Calibration for a couple of 
more times. If the calibration still returns fail, the device is out of specification.  
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Notices	
© Copyright 09/2019 CEVA, Inc. and/or its subsidiaries (“CEVA”) All rights reserved. All specifications are 
subject to change without notice. 

Freespace is a registered trademark of CEVA. Other company and product names mentioned in this 
document may be the trademark or registered trademark of their respective owners. 

Disclaimer: The information furnished herein is believed to be accurate and reliable. However, the 
information is provided “AS IS”, without any express or implied warranty of any kind including warranties 
of merchantability, non-infringement of intellectual property, or fitness for any particular purpose.  

In no event shall CEVA or its suppliers be liable for any claims and/or damages whatsoever arising out of 
the use of or inability to use the materials. CEVA and its suppliers further do not warrant the accuracy or 
completeness of the information, text, graphics or other items contained within these materials. CEVA 
may make changes to these materials, or to the products described within.  
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